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E1-CG: Introducing Cabri Geometry II plus1

By Judith N Cederberg

Introduction:

Cabri Geometry II plus (an enhanced version of Cabri Geometry II) enables computer construction of
geometric figures as well as elementary transformations of these figures. To get more detailed information
about obtaining and using Cabri, see the Cabrilog website at http://www.cabrilog.com/en/.

This document gives step-by-step directions for carrying out some of the constructions possible with
Cabri. As you carry out the constructions described below, note any questions you have about specific
features of the program. If this is your first exposure to a computer drawing program, you will find that
the beginning exercises will take considerably longer for you than for others who have some familiarity
with such programs. However, your initial patience and persistence will soon pay off and you too will
soon be a “pro.”

How To Begin:

You will need to open the Cabri program by double clicking on the appropriate icon. This should bring
up an initial credit screen. Click on it to remove the credits and bring up a screen entitled “Figure #1.”
As in other drawing programs, you carry out commands by moving the cursor around the screen using
the mouse and clicking on the item you wish to select. In some cases, you can select several objects at
once by holding down the shift key while clicking on the objects one at a time. If you want to deselect
all your selected objects, move the cursor to an empty portion of the screen and click. To deselect just
one of a collection of selected objects, continue holding down the shift key and click on the object to be
deselected.

General Procedures:

• Constructions: New Cabri users should activate Help in the Help menu to create a window
at the bottom of the screen where a list of objects required for a construction will appear once
a tool is selected. The construction tools are “contained” in the toolbox in the toolbar at the
top of the screen. To see which tools are in a particular toolbox, move the cursor to the toolbox
button and click and hold down the mouse button. The toolbox button will become lighter. As
you move the cursor over a tool name, the icon for that tool will appear and the name of the tool
will appear at the bottom of the screen. Move the cursor (whose shape may now have changed) to
an appropriate location on the screen. If the construction requires specific points, e.g., endpoints
for a segment, you will need to click on the locations of those points to perform the construction.
You can continue performing this same construction as long as the appropriate tool is selected.
If you wish to perform the construction represented by the visible icon after other intermediate
operations, merely click on the icon again to activate the tool.

• Moving Objects: To move an object to a new location on the screen, you must select the
Pointer (found in the left-hand most toolbox) and then move the cursor to the object and wait for
the pointer message “This [named object]” to appear. If instead, the message “Which Object?”
appears, click to generate a popup menu that names the possible objects and select the one desired.
Once the appropriate name appears, click the mouse to change the cursor to a curled hand. Hold
the mouse button down while moving the cursor and the object to a new location.

• Erasing: To undo or erase a construction or transformation just completed, merely choose Undo
under the Edit menu. If you want to redo the previously undone operation, choose Redo. To
delete a small number of objects, select the objects to be deleted and hit the “Delete” key. Note
that any objects whose construction was dependent on the deleted objects will also disappear.

1Designed to supplement Chapter 1 in A Course in Modern Geometries, 2nd Ed.; revised by JNC Jan. 3, 2007. Source
File: My Documents\Text.dir\Web-exp.dir\e1cg+07.tex



2 E1-CG

• Changing Attributes: To activate the attributes bar, select Show Attributes in the Options
menu. Tools in this bar enable changes in attributes of color, style, size, etc. To use a new
color, thickness, etc., for objects yet to be constructed, choose the construction tool, then select
the attribute from the icons in the attributes bar and then construct the object. To change the
appearance of an object already constructed, select the appropriate tool from the Draw toolbox
and then “paint” your object with the tool.

Exploration Activities:

With this quick introduction, you should be able to carry out the elementary Euclidean constructions
described below. These activities illustrate the use of a variety of tools in the Cabri toolboxes (indicated
in boldface).

1.1.1 Triangle Construction and Measurement:

1. In the Lines toolbox select Triangle. Then click the mouse consecutively at three vertex locations.

2. To label the vertices as A, B, and C, select Label from the Display toolbox. Move your cursor
to each vertex; wait for the pointer message “This Point,” click to make an edit box appear, and
then type the desired label. To change or delete a label with the Label tool, click on the label.
Once the edit box appears you can make the desired changes. Later, with the Pointer selected,
you can change a label without invoking the Label tool, by double clicking the Pointer on the label
to invoke the editor. Labels can be moved using the Pointer but most will stay near the object
they name.

3. Select Distance or Length from the Measure toolbox. Move the cursor to a side of the triangle
and click. Note that the measure of the perimeter (in cm) appears. Immediately type a label for
this measurement to indicate that it is the perimeter.

4. With the Distance or Length tool still selected, measure the sides by moving the cursor to a
vertex of the triangle. Wait for the pointer message “Distance from this point” to appear. Then
click the mouse and move to the second vertex. Once the message “to that point” appears, click
again. When the distance appears, label it appropriately. You may want to move the distance
measurements away from the triangle by using the Pointer to drag them (They will move after an
initial hesitation.).

5. Use the Pointer2 to select and move individual vertices of your triangle until the screen recorded
measurements of the lengths of the sides of ∆ABC indicate that you have an equilateral triangle
(or a close approximation).

6. With the Angle tool from the Measure toolbox selected, click consecutively on the three vertices
to measure 6 ABC. Label your measure. Then find and label the other two angle measures. Do
your angle measurements verify that ∆ABC is an equilateral triangle?

7. Drag point A until the screen recorded measurement indicates that ∆ABC is a right triangle, with
right angle at C. To verify that you have a right triangle, follow the procedure below to have Cabri
carry out the computation:

√
d2(A,C) + d2(B,C)

(a) Select Calculate from the Measure toolbox to make a calculator appear on screen.

(b) First click on the sqrt “key”.

(c) Then click on the numerical value of d(A,C) and notice that a “variable” representing this
quantity appears in the calculator window. Complete entering the expression above by clicking
on the appropriate “calculator keys” and the other measurements and entering numbers for
exponents from the keyboard. Then click on the “=” sign to get your result.

2Since the Pointer is used frequently, a Cabri shortcut allows you to access the Pointer by clicking the mouse key
anywhere in the gray area of the Toolbar.
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(d) What should the answer be? Did you get that result?

(e) To record your result on-screen, right click on the numerical answer in the calculator to copy
the result. Then paste the result at the desired position. Use Text from the Display toolbox
to label your result.

8. Select the entire triangle.3 With the triangle selected, place the Pointer on any part of the triangle
and drag the triangle to a new position on the screen. Do your measurements change?

9. Use the following procedure to save your figure:

• In the (L:) Class Shared Student Folder, create a folder titled “E1-∗ ∗ ∗ ∗ ∗∗” where the 6 ∗’s
are replaced by first and last initials of each of you in your group.

• Select Save As under the File menu. Then enter the name “RtTriang.” Note that some
computers automatically add the “.fig” extension so the name becomes “RtTri.fig.” If yours
does not, add the “.fig”

• Then click on Save.

Comments:

As the previous exercises demonstrated, the triangle you constructed was non-rigid, i.e., the lengths of
its sides and the measure of its angles change if a vertex is dragged. There are times when it is important
to generate objects that maintain certain properties when any part is dragged. The following exercises
lead you through the construction of several such polygons.

1.1.2 Equilateral Triangles, Squares and Rectangles:

1. Equilateral Triangle Construction via Euclid4:

(a) Open a new drawing window (see File menu). Select the Segment tool. To construct and
label the first endpoint, first click at the desired location and then type the letter A. Move
the cursor to the second endpoint of your segment, click and type the letter B.5

(b) Select Circle in the Curves toolbox. Move the cursor towards point A until the pointer
message “This center point” appears. Click once; then move the cursor towards B and click
again once the message “This radius point” appears. Construct a second circle with center
at B and radius point A.

(c) Use the Intersection Point tool in the Points toolbox to construct one of the points of
intersection of these circles. Label this point C.

(d) Complete the triangle by constructing the segments AC and BC. Then use the Hide tool in
the Display toolbox to select the two circles.

(e) Measure each of the sides of your triangle to verify that it is an equilateral triangle.

(f) Try dragging each vertex in turn and note whether the vertex can be moved. Once you have
determined which vertices can be moved, move the cursor to an unoccupied space and press
and hold the mouse key for several seconds until objects begin flashing. How do the flashing
objects relate to your determination?

(g) Watch the measurements to verify that the shape of the triangle remains the same as you
increase or decrease the length of a side.

(h) Save your figure as “EquTri.fig”

2. Square Construction via Cabri’s Regular Polygon Tool:
3To do this efficiently, click in a blank area above and to the left of the triangle. Then while holding down the mouse

button, drag the cursor down and to the right to create a rectangular area of selection surrounding the triangle. When the
area of selection surrounds the triangle, release the mouse button.

4This construction was used by Euclid to prove the first proposition in The Elements.
5This way you can label objects as you create them without changing to the Label tool.
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(a) Open a new drawing window (see File menu).
(b) Select Regular Polygon from the Lines toolbox.
(c) Move your cursor and click at a location for the center of your square. Then move the cursor

away from the center and click at a location for a vertex.
(d) A regular polygon6 with a large number of sides will appear (The number is indicated in the

center of the polygon.) To reduce the number of sides to 4, click on an endpoint of your
original segment and move the cursor clockwise. You might find it interesting to note what
happens if you move the cursor the other way.

(e) Check the “rigidity” of your square by trying to drag each vertex. Which of the vertices can
be moved? What happens when you move them?

(f) Save your figure as “Squ.fig”

3. Rectangle Construction:

(a) Open a new drawing window and construct a segment AB. Label the endpoints.
(b) Select Perpendicular Line in the Construct toolbox. Click on B, then on segment AB to

obtain a line perpendicular to AB at B.
(c) Use Point on Object to locate a point on this perpendicular; immediately type C to label it.
(d) Construct segment BC and hide the perpendicular line.
(e) Select Parallel Line in the Construct toolbox and construct a line through C parallel to AB

and another line through A parallel to BC.
(f) Use Intersection Point to locate point D, the last vertex of your rectangle.
(g) To check that AD is perpendicular to AB, select Perpendicular from the Check Property

toolbox. Then move the cursor to first one of the lines, then the other. Move the marquee
box that appears to a convenient location. A comment indicating whether or not your lines
are perpendicular should appear.

(h) Construct segments AD and CD and hide the corresponding lines.
(i) Measure each of the segments and one of the angles to verify that you have a rectangle.

Check that quadrilateral ABCD remains a rectangle as you drag its vertices. Determine how
dragging each vertex affects the rectangle.

(j) Select Text from the Display toolbox and move the cursor to an empty region of your screen.
In the edit box that appears, type a description of the effect on the rectangle of moving each
vertex. To change the shape of your edit box, move the cursor to the lower righthand corner
of the box until an double arrow appears. Then click and drag the corner to change the box
dimensions.

(k) Save your figure as “Rect.fig”

4. Square Construction from an Initial Side:

(a) Open a new drawing window. In it construct a segment and label its endpoints A and B.
(b) To rotate point B through 90o about A. . .

• In the Display Toolbox select Numerical Edit and click someplace on the screen. Type
90 in the box that appears. To record the units as degrees, press the CTRL and U keys
to display the popup unit menu.

• In the Transform Toolbox select Rotation, and click successively on points B, A and
the angle value. Label the new point D and construct segment AD.

(c) Now construct and label the square’s remaining sides, BC and CD.
(d) Try dragging each vertex of your square and record what happens using the Text tool.
(e) Save your construction as “Side-squ.fig”

6A regular polygon is a polygon with all its sides equal and all its angles equal.
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1.1.3 Creating Macros:

Cabri’s Macro toolbox (identified with the X→ icon) allows you to create your own tailor-made tool by
carrying out the construction and then identifying first the initial objects and second the final objects.
The created macro then enables you to duplicate the construction by merely setting up the required initial
objects. The following exercises will lead you through the creation of a macro for Euclid’s construction
of an equilateral triangle.

1. A Macro for Equilateral Triangles:

(a) Reopen your file “Equ-triangle.fig,” or reconstruct an equilateral triangle as outlined in 1.2.2.
Recall that you only have one initial object (the object on which everything else depends),
namely, the first segment you constructed.

(b) Select Initial Objects from the Macro toolbox and then select this first segment.

(c) Select Final Objects from the same toolbox and then select the remaining two sides of your
triangle.

(d) Finally, select Define Macro in the Macro toolbox. A “Define Macro” window should appear.
In it enter a name for your macro and check the Save to File box. Your macro name will
appear temporarily in the Macro toolbox.

(e) The “Define Macro” window also creates (or allows you to create) an icon button for your
macro. To create your own, choose a color and select pixels to be colored. Also enter the
name of the final object and a help message. The latter should explain what needs to be
selected as the initial objects.

(f) Save your macro as “EquTri.mac”7”

(g) Your new macro should now appear in the Macro toolbox.

(h) To try out the macro, construct the initial object (here a segment). Select your new macro
from the Macro toolbox and then select the segment. An equilateral triangle should appear.

(i) Construct a new initial segment by reversing the cursor direction you used for the previous
initial segment (If you constructed the first segment from left to right, this time move from
right to left.). Apply your macro to this new segment. What happens?

(j) Try applying your macro to the sides of your new triangle.

2. Create a macro that creates a square from an initial side. Save it as “SideSqu.mac”

3. (Optional) Create a macro that creates a regular hexagon from an initial side. Save it as
RegHex.mac”

Report:

Your folder E1-****** should contain the files below. Submit your work by placing a copy of this folder
in the Class Drop Box.

1. Figures: 2. Macros:
(a) RtTri.fig (a) EquTri.mac
(b) EquTri.fig (b) Squ.mac
(c) Squ.fig (c) RegHex.mac (optional)
(d) Rec.fig
(e) SideSqu.fig

7Your computer may automatically attach this extension.


